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Incorporating NCED data into Biotics 

National Conservation Easement Database (NCED): Background 

information 

What is the NCED? 

http://www.conservationeasement.us/ 

http://nced.conservationregistry.org/ 

http://nced.conservationregistry.org/pdf/NCED_Users_Guide_6_8_2011.pdf 

The National Conservation Easement Database (NCED) is the first national database of conservation 

easement information, compiling records from land trusts and public agencies throughout the United 

States. Voluntary and secure, the NCED respects landowner privacy and does not collect landowner 

names or sensitive information. This public-private partnership brings together national conservation 

groups, local and regional land trusts, and state and federal agencies around a common objective. The 

NCED provides a comprehensive picture of the estimated 40 million acres of privately-owned 

conservation easement lands, recognizing their contribution to America’s natural heritage, a vibrant 

economy, and healthy communities. 

Purpose 

In collaboration with land trusts and public agencies, create a single, up-to-date, sustainable nationwide 

system for managing and accessing data about conservation easements. 

Who? 

The U.S. Endowment for Forestry and Communities, with generous support from the Gaylord and 

Dorothy Donnelly Foundation, is providing the funding for the project to five leading conservation 

organizations, including: Conservation Biology Institute, Defenders of Wildlife, Ducks Unlimited, 

NatureServe, and The Trust for Public Land. Three federal agencies - the U.S. Fish & Wildlife Service, U.S. 

Department of Agriculture's Natural Resources Conservation Service, and the U.S. Forest Service - are 

sponsors of the effort and are partnering with the Endowment in support of the national database. 

Other key sponsors include The Nature Conservancy and the Land Trust Alliance. 

Obtaining NCED data 

The NCED Easement data is available for download as both shapefiles and as a geodatabase on the 

NCED Data Download page, however for the purpose of this exercise, download the data as a 

geodatabase. You can download either the national dataset or the data for a particular region: 

http://nced.conservationregistry.org/easements/download_data 

 

See Appendix I for the NCED Data Dictionary. 
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Extract the zipped geodatabase file to C:\TEMP. 

Download the necessary scripts, MS Access database, etc. from the Biotics Trainings & Clinics web page 

under the Materials section for the Support Clinic hosted on Aug 3, 2011.  Alternatively, it can be 

downloaded from the NatureServe transfer site.  

Export Data from Geodatabase 
Both the spatial data and tabular data will be exported for separate import processes into Biotics.  

Because .dbf tables truncate data to 255 characters per field, we’ll export the tabular data to a text file 

rather than use it from the shapefile’s .dbf file. 

Export Spatial Data 

1. In ArcMap, right select your NCED geodatabase within the table of contents (assuming it has 

been added to the view). 

2. Right click on the geodatabase and choose Data - Export Data. 

3. Navigate to where you would like to save the shapefile and name it appropriately (e.g. 

X:\Whitney\NCED\NCED.shp). 

 
 

Export Tabular Data 

4. Right click on the geodatabase and choose Open Attribute Table. 

5. Within the attribute table choose Options and Export 
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6. Navigate to where you would like to save the tabular data and name it appropriately (e.g. 

X:\Whitney\NCED\NCED.txt), making sure to select Text File from the “Save as type” dropdown 

list. 

 

 

Create NCED table in Biotics 
The NCED data will be imported into some existing Managed Area fields but many additional fields were 

required to accommodate the data.  Therefore the remaining data will be imported into an extensible 

table which will be created with the MA_EXT_NCED.sql script.  The script will write a log file to the 

C:\temp directory so make sure one exists and you have write access to it! 

1. Log into SQLPlus as the biotics_user. 

2. Run the MA_EXT_NCED.sql script. 
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3. Review the log file (C:\temp\MA_EXT_NCED.log) for errors by searching for ORA-.  Ignore any of 

the following error: “ERROR at line 1: ORA-00942: table or view does not exist”. 

4. If you receive additional errors, submit an issue to the Biotics Help Desk with the subject line 

“NCED”.  Attach the MA_EXT_NCED.log file to the issue. 

5. Do not exit SQLPlus as we will be using it again later. 

Import Tabular Data into NCED Extensible table in Biotics 
The following instructions assume that you want to import ALL of the data from NCED into Biotics, 

however, some of the data may already be represented in Biotics (perhaps indicated as such by a 

Managed Area code (i.e. M.USFLHP*xxxx) within the Origuid field.  Any such records which already exist 

in Biotics should be not be included in the data to be loaded in Biotics, to avoid duplications. 

Connect to your Biotics database 

1. Double-click NCED.accdb found within C:\Temp\NCED to open the NCED Access database . 

2. If within the Access database you receive a Security Warning stating that certain content has 

been disabled, click Options and choose to Enable this Content. 

3. Under the BIOTICS_USER_MANAGED_AREA_OWNER section, double-click 

BIOTICS_USER_MANAGED_AREA_OWNER to connect to the data within your Biotics Oracle 

database. 

4. Within the Oracle ODBC Driver window, enter the appropriate Service Name, User Name, and 

Password to connect to your Biotics database and click OK. 
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Import NCED tabular data into Access 

1. Right click on NCED : Table and choose Import – Text File. 

 

 

2. Within the Get External Data – Text File dialog, navigate to where you saved the tabular data 

you exported from the attribute table in ArcMap (e.g. C:\Temp\NCED\NCED.txt) and click OK.  

Because the data will be entered into multiple tables, we can’t append it directly at this point. 

 

 

3. Within the Import Text Wizard accept the default of Delimited and click Next. 
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4. Maintain Comma as the delimiter and make sure to indicate First Row Contains Field Names 

prior to clicking Next. 

 

 

5. From the dropdown list of the Indexed field for the OBJECT_ID field name, select Yes (No 

Duplicates). 
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6. Scroll to the right until you find the DataEntry field.  Select it and change the Data Type to Text.  

Failing to do so will result in import errors as Access doesn’t recognize the date/time format in 

the data set.  Click Next. 

 

 

7. Accept the default of Let Access add primary key and click Next. 

 

 

8. Name the table NCED and click Finish.  Failing to name it exactly will result in the automated 

query failing. 
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Transfer data from Access to Biotics 

1. Under the “NCED” heading, double-click the Populate CoHeld query which will populate any null 

values in the CoHeld field to ‘N’.  This is required for a boolean field. 

2. Under the “Unrelated Objects” heading, double-click the NCED to BIOTICS_USER_NCED Query 

which will export the data from the NCED table in Access to the NCED table in Biotics (i.e. 

BIOTICS_USER_NCED). 

3. Return to SQLPlus (should still be logged in as the biotics_user) and run the 

incongruous_data_values.sql script found within C:\Temp\NCED. 

 

4. Open the resulting log file INCONGRUOUS_DATA_VALUES.log found in the C:\TEMP\NCED 

directory.  The file reports any values within your NCED data which which do not align with the 

values within the corresponding domain tables. 

5. Edit the NCED.sql script in NotePad (or WordPad or…) and add to the UPDATE statements to 

accommodate for all of the incongruous data values, assigning the appropriate ID value.  Failing 

to do so will result in the value not being imported. 
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For example, if you have a value of LandType=’NGO’, select the D_OWNER_TYPE_ID (33) which 

corresponds to ‘Non-Governmental Organization’.  You can find the appropriate ID value by 

looking at the D_OWNER_TYPE table via Tracker’s Query Builder. 

6. Once you have updated the NCED.sql script as necessary, run it in SQLPlus.  This script will 

assign domain IDs for the corresponding tabular data. 

7. In Microsoft Access, under the Unrelated Objects section, double-click the BatchScript1 to open 

it. 

8. Within Microsoft Visual Basic – NCED, click the  icon to run BatchScript1. 

9. In the Macros window, click Run which will run a number of queries to populate the SHAPE and 

NCED tables. 

 

10. Reply Yes when prompted six (?) times regarding appending data to your table.  NOTE: This will 

take a while to run and may appear as though it’s done but will then come up with another 

hourglass indicating that it’s still working.  It has finished once the BIOTICS_USER_NCED No 

Name Query table has opened. 
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11. Once the BIOTICS_USER_NCED No Name Query table has opened , close the Microsoft Visual 

Basic – NCED window. 

12. BatchScript1 runs a query (BIOTICS_USER_NCED No Name Query) to identify which records do 

not  have an easement name.  These records need to be given names in the SiteName field prior 

to continuing with step 8 or they will not be inserted into the MA table, as name is a required 

field. 

13. Under the BIOTICS_USER_NCED section, double-click the BIOTICS_USER_NCED to 

BIOTICS_USER_MA Query.  Respond Yes when prompted to append the data. 

14. In SQLPlus while logged in as the biotics_user, run the following statements: 

Update nced set managed_area_id = (select managed_area_id from ma where 

rec_create_user=’NCED’ and ma.shape_id=nced.shape_id); 

Commit; 

15. In Microsoft Access, under the Unrelated Objects section, double-click the BatchScript2 which 

will run queries to populate the MA_EXT_NCED and MANAGED_AREA_OWNER tables. 

16. Within Microsoft Visual Basic – NCED, click the  icon to run BatchScript1. 

17. In the Macros window select Database2.BatchScript2.run_queries and click Run. 

 

18. Reply Yes when prompted four (?) times regarding appending data to your table. 

The tabular data has now been populated in Tracker.  At this point we’ll link the spatial data from 

NCED.shp to the tabular records. 
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Extend Tracker to Accommodate NCED Data 

Create Extensible Tab in Tracker 

Just as an FYI, Administrator aborted multiple times during the creation of these extensible tabs, which 

resulted in inefficiency to say the least.  Whether this is due to the number of fields on the tabs or an 

issue with my computer, I don’t know.  Regardless, creating the extensible tabs in the following manner 

will enable you to avoid such pitfalls:  

• Fill out the first (Object) section 

• Within the Table Column information, fill complete the configuration for the first 3 fields, then 

uncheck ‘Visible’ for the remaining fields.  Failing to do so will require you to label them all prior 

to saving.  Click OK to save the changes. 

• Edit the tab to continue, labeling and making visible all but the fields which utilize a ComboBox 

(domain attributes).  Click OK to save changes. 

• Edit the tab and configure the remaining (domain) attributes which utilize a ComboBox and 

make them visible. 

 

1.  In the Biotics Administrator, create extensible tabs according to directions within section 8.4 

(Configure Dynamic Tabs) of the Biotics 4.0 Installation, Configuration, and Administration 

Guide. 

a. Create extensible tab for MA_EXT_NCED as shown below: 
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Column Name 

Control 

Type Label Text 

Primary 

Key 

Foreign 

Key 

Visibl

e Domain Table Data Column Display Column Display Width 

MA_EXT_NCED_ID 

  

X 

      
NCED_ID TextBox NCED ID 

  

x 

    MANAGED_AREA_I

D 

   

X 

     
US_ID TextBox Unique ID (USGS) 

  

x 

    

D_CATEGORY_ID ComboBox Category 

  

x D_CATEGORY D_CATEGORY_ID 

DISPLAY_VALU

E 15 

D_P_DES_TP_ID ComboBox Primary Designation Type 

  

x D_P_DES_TP D_P_DES_TP_ID 

DISPLAY_VALU

E 100 

P_LOC_DS TextBox Primary Local Designation Type 

  

x 

    

D_SEC_DES_TP_ID ComboBox Secondary Designation Type 

  

x 

D_SEC_DES_T

P 

D_SEC_DES_TP_I

D 

DISPLAY_VALU

E 100 

S_LOC_DS TextBox Secondary Local Designation Type 

  

x 

    
S_DES_NM TextBox Secondary Designation Name 

  

x 

    
S_LOC_NM TextBox Secondary Local Name 

  

x 

    

D_STATUS_ID ComboBox Status 

  

x D_STATUS D_STATUS_ID 

DISPLAY_VALU

E 100 

D_STATE_NM_ID ComboBox State Name 

  

x D_STATE_NM D_STATE_NM_ID 

DISPLAY_VALU

E 15 

WDPA_CD TextBox WDPA Site Code 

  

x 

    

D_GAP_STS_ID ComboBox GAP Status Code 

  

x D_GAP_STS D_GAP_STS_ID 

DISPLAY_VALU

E 100 

D_IUCN_CAT_ID ComboBox IUCN Category 

  

x D_IUCN_CAT D_IUCN_CAT_ID 

DISPLAY_VALU

E 100 

GAPCDSRC TextBox GAP Status Code Source 

  

x 

    

GAPCDDT 

Date 

Control GAP Status Code Date 

  

x 

    
AGG_SRC TextBox Aggregator Source (Data Aggregator) 

  

x 

    
GIS_SRC TextBox GIS Source (Data Source) 

  

x 

    
GLOBALID TextBox Global ID (USGS) 

  

x 

    

REC_CREATE_DATE 

Date 

Control 
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b. Create extensible tab for MA_EXT_NCED_CBI as shown below: 
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Column Name 

Control 

Type Label Text 

Primary 

Key 

Foreign 

Key Visible Domain Table Data Column Display Column 

Display 

Width 

MA_EXT_NCED_ID 

  

X 

      
NCED_ID TextBox NCED ID 

  

x 

    
MANAGED_AREA_ID 

   

X 

     
SECURITY CheckBox Security 

  

x 

    
ORIGINAL_UID TextBox Unique ID (CBI) 

  

x 

    
ESMT_HLDR TextBox Easement Holder 

  

x 

    
D_ESMT_HLDR_TYPE_ID ComboBox Easement Holder Type 

  

x D_ESMT_HLDR_TYPE D_ESMT_HLDR_TYPE_ID DISPLAY_VALUE 100 

COHELD CheckBox CoHeld 

  

x 

    
D_DURATION_NCED_ID ComboBox Duration 

  

x D_DURATION_NCED D_DURATION_NCED_ID DISPLAY_VALUE 15 

TERM TextBox Term 

  

x 

    
ACQ_DAY TextBox Acquisition Day 

  

x 

    
ACQ_MONTH TextBox Acquisition Month 

  

x 

    
ACQ_YEAR TextBox Acquisition Year 

  

x 

    
DATAPROVIDER TextBox Data Provider 

  

x 

    
D_BOUND_CONF_ID ComboBox Boundary Confidence 

  

x D_BOUND_CONF D_BOUND_CONF_ID DISPLAY_VALUE 75 

D_PURPOSE_ID ComboBox Purpose 

  

x D_PURPOSE D_PURPOSE_ID DISPLAY_VALUE 25 

REPORTED_AREA TextBox Reported Area 

  

x 

    
REC_CREATE_DATE Date 

        



  
Page 15 

 

  

Set Security for new Extensible Tabs 

See Section 8.5 (Security for Dynamic Tabs) of the Biotics 4.0 Installation, Configuration, and 

Administration Guide. 

1. Within Biotics Administrator, double-click Functions. 

2. Complete the Functions window as displayed below and click Edit 

 

3. Within the Control List section of the Function Manager, expand ManagedAreaDetails. 

4. Select all references to MA_EXT_NCED_and MA_EXT_NCED_CBI and hit the  icon to add 

them to the Selected Controls.  NOTE: These should be easy to find due to the all caps.  Each tab 

has three sets of controls: Control Types, Lables, and Picture Box, so make sure to scroll all the 

way through ManagedAreaDetails and select them all. 
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5. Click OK and Close the Functions window. 

6. Exit Biotics Administrator.  The two tabs should now be editable in Tracker.  

Import Spatial Data in Mapper 
1. In Mapper, close the View window by clicking on the x in the right hand corner (not the 

uppermost  x, as this will close Mapper) 

2. In the ArcView project window, from the ‘Project’ menu, choose ‘SQL Connect’ 
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3. In the ‘SQL Connect’ window, choose the ‘Connection’ of ORA_SERVER. 

4. Click Disconnect then Connect. 

5. In the Oracle ODBC Driver Connect prompt, enter the password for your biotics_user and click 

OK. 

 

6. Complete the SQL Connect window as shown and described below:  
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i. In the ‘Tables’ dropdown list, choose the MA_EXT_NCED table – double click on it, 

so “MA_EXT_NCED” is populated in the ‘from:’ box. 

ii. In the ‘Columns’ dropdown list, choose the <All Columns> table – double click on it, 

so * is populated in the ‘Select:’ box. 

iii. Rename the ‘Output Table:’ to MA_EXT_NCED 

iv. Hit the Query button then hit Clear. 

v. The MA_EXT_NCED table will open. 

vi. Repeat the steps above to add the MA table but rather than selec ting <All 

Columns> under the Columns section, just select MANAGED_AREA_ID and 

SHAPE_ID. 

vii. After completing the SQL Connect window as shown below, click Query and then 

close the window. 
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viii. The MA table will open. 

b. From the Window menu, choose View1 to switch to the View.  If it’s not available, within the 

Project window’s Table of Contents, click View, select View1 and click Open. 

c. Within the View, add the NCED.shp theme to the window (File menu, Long Menus, Add Theme 

icon ) 

d. Select the theme in the Table of Contents to make it active and from the Theme menu, choose 

Start Editing. 

e. Open the attribute table: 

i. From the ‘Theme’ menu, choose ‘Table’ or 

ii. Click the ‘Open Theme Table’ icon  

f. From the Edit menu, choose Add Field. 

g. Within the Field Definition, enter US_ID as the Name and (maintaining the default choice of 

Type = Number, Width = 16, Decimal Places = 0) click OK. 
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h. From the Field menu choose Calculate. 

i. Within the Field Calculator, double-click the [Uid] field and type .asnumber and click OK, as 

illustrated below. 

 

j. From the ‘Window’ menu, choose ‘Tile’ so that you can see both the theme’s attribute table and 

the MA_EXT_NCED table.  If the MA_EXT_NCED table is not displayed follow the instructions 

below: 

i. In the Project window, select Tables from the Table of Contents. 

ii. From the Project menu, select Show All Tables. 

iii. Select the MA_EXT_NCED table and click Open. 

iv. Within the MA_EXT_NCED table, again go to the Window menu and select Tile 

to see both the MA_EXT_NCED and Attributes of Nced.shp tables at the same 

time. 

k. In the MA_EXT_NCED table, highlight the US_ID field. 

l. In the Attributes of Nced.shp table, highlight the corresponding US_ID field. 

m. With the Attributes of Nced.shp table active, from the ‘Table’ menu, choose ‘Join’.  This will join 

the data from the MA_EXT_NCED table to the Attributes of Nced.shp file. 

n. In the MA table, highlight the MANAGED_AREA_ID field. 

o. In the Attributes of Nced.shp table, highlight the corresponding MANAGED_AREA_ID field. 
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p. With the Attributes of Nced.shp table active, from the ‘Table’ menu, choose ‘Join’.  This will join 

the data from the MA table to the Attributes of Nced.shp file. 

7. Click on View1 and from the Theme menu choose Stop Editing, responding Yes when prompted 

to save changes. 

8. From the Biotics menu choose Input/Edit. 

9. Within the BIOTICS – Input/Edit window, choose Managed Areas and click OK. 

10. From the Admin menu choose Batch Link Shapes to Data Records. 

11. Within the Choice window, select Nced.shp from the dropdown list as the theme containing the 

shapes to be match/linked to existing data and click OK. 

12. Within the Choice window, select SHAPE_ID from the dropdown list as the field from ‘Nced.shp’ 

to link to the FEATURE_ID field in the editable theme and click OK. 

13. In the Warning dialog, confirm the number of records to be processed.  This number should 

correspond to the number of records you loaded into the tabular database.  Click Yes to 

continue. 

 

14. When the progress bar and all working dialogs have finished, be sure to query the new records 

in Mapper and Tracker to confirm that they were linked correctly. 

15. Click the Close Input/Edit button to end the edit session and post the changes to the master 

database. 
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Appendix I: NCED Data Dictionary 
Below is an explanation of the attributes for the NCED database.  For more specifics on the attribute 

fields and domains in the geodatabase, please see the following table. 

 

Security – Whether or not the spatial or tabular data can be displayed or download by the general 

public. 

 

Site Name – Site name of easement.   

Easement Holder Name – Name of the organization managing or holding the easement. 

Easement Holder Type – Federal, Tribal, State, Regional agency, Local Government, Non-Governmental 

Organization (NGO), or Private 

Landowner Type – Federal, Tribal, State, Regional agency, Local Government, Non-Governmental 

Organization (NGO), or Private 

Purpose – This attribute describes the easement's intended conservation purpose. The list below shows 

the name of each domain value (from IRS code) followed by its definition (summarized from IRS 

code).  The definitions are mutually exclusive, which will minimize questions.  For Open Space, there 

are 4 sub-values, which the IRS mentions, including "other". 

Domain Definitions:  

• Recreation or Education (26 CFR 1.170A-14(d)(2)) - requires substantial and regular use by the 

general public, and does not fit any other definition. 

• Environmental System (26 CFR 1.170A-14(d)(3)) - Protects significant, high quality examples of 

terrestrial or aquatic habitats or ecosystems where a fish, wildlife or plant community live. 

These include but are not limited to, habitats for rare, endangered, or threatened species, or 

lands contributing to the ecological viability of another conservation area. 

• Open Space (26 CFR 1.170A-14(d)(4)) - provides scenic (i.e., visual) enjoyment for the general 

public, helps fulfill a public policy that provides open space by restricting development, or serves 

another significant public benefit such as preserving the uniqueness of the surrounding area or 

consistency with public policies promoting conservation.  Sub-values:  farm (if the land is to be 

planted with annual plants in part or in full any time during the term of the easement); ranch (if 

the land is to be hayed or grazed and not planted with an annual); forest (if the land is to be 

forested and not farmed or ranched); other (if nothing else applies, e.g., for a beach or marsh). 

 Display   Download Display Download 

Security Attribute Tabular Data Tabular Data Location Location 

Yes Yes Yes No No 

No   Yes Yes Yes Yes 

No download Yes No Yes No 
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• Historic Preservation (26 CFR 1.170A-14(d)(5)) - protects historic values of an area or structure 

that either is officially designated as such or adjoins such an area or structure, or presents 

historic values consistent with such official designations. 

 

Public Access – Open – Open to public access 

  Restricted – Public access is restricted 

  Seasonal – Public access is limited on a seasonal basis 

  Closed – No public access 

Duration –  Permanent or Temporary 

Term – Term of easement (number of years; if the duration is “Permanent” then the value for the 

“term” is null. 

Acquisition Day – Day easement began 

Acquisition Month – Month easement began 

Acquisition Year – Year easement began 

Boundary Confidence – Accuracy of the geometry, where known.  

Reported Area – Acres 

GIS Area – Auto calculated by system, acres.  

Area Difference – Calculated percent difference between the GIS Area and Reported Area. 

Comments – If provided by source, provider or aggregator, include in NCED. 

Conflict – Whether or not there is a conflict between an NCED polygon and either a different NCED 

polygon or PAD polygon.  Where we are able to correct or adjust through knowledge of the data of 

from data provider input, data aggregators will use domain of Conflict – Adjusted.  Where 

aggregators are unable to determine the appropriate adjustment, the Conflict – Not Adjusted 

domain will be used.  This field could also be used to categorize gaps in data as well. 

Stacked – Where polygons are appropriately stacked, that will be noted in this attribute. 

 

Geodatabase table of attributes, alias, description, domains, type and length: 

 

Field Name Alias Field Description Domain Field Type Field Length 

UID Unique ID Unique identifier  Text 15 

Security Security Code Privacy 

requirements for 

the polygon 

Yes 

No 

NO NULL 

Text 5 

SiteName Site Name The name of the 

site (E.g. Smith 

Preserve) 

 Text 100 
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Field Name Alias Field Description Domain Field Type Field Length 

EsmtHolder Easement 

Holder 

Name of the 

organization 

managing or 

holding the 

easement 

No, but values should be 

ties to the Quickbase 

Inventory List and be in a 

standard format 

Text 100 

EsmtHolderType Easement 

Holder Type 

Whether the 

holder of the 

easement is a 

federal, state, local, 

tribal, or other 

legal classification 

Federal 

Tribal 

State 

Regional Agency 

Local Government 

Non-Governmental 

Organization 

Private 

Data not available 

NO NULL 

Text 50 

LandownerType Landowner 

Type 

Whether the owner 

of the underlying 

land is a federal, 

state, local, tribal, 

or other legal 

classification 

Federal 

Tribal 

State 

Regional Agency 

Local Government 

Non-Governmental 

Organization 

Private 

Data not available 

NO NULL 

Text 50 

CoHeld Co-Held Whether the 

easement is co-

held by multiple 

entities 

Yes 

No 

Text 3 

Purpose Conservation 

Purpose 

The easement’s 

intended purpose, 

based on IRS Code 

Recreation or Education 

Environmental System 

Historic Preservation 

Open Space – Farm 

Open Space – Ranch 

Open Space – Forest 

Open Space - Other 

Data not available 

Text 50 

ConsIntent Conservation 

Intent 

The conservation 

intent of the 

easement , based 

on GAP Code 

0 - Temporarily 

Unassigned 

1 - Permanent Protection 

-- ecological disturbance 

events allowed to proceed 

2 - Permanent Protection 

-- ecological disturbance 

events suppressed 

3 - Permanent Protection 

-- subject to extractive 

(e.g. mining or logging) or 

OHV use 

4 - No known mandate for 

protection 

Text 5 
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Field Name Alias Field Description Domain Field Type Field Length 

4a - Long-term 

conservation easement 

(6-14 years) 

4b - Short-term 

Conservation easement (5 

years or less) 

PublicAccess Public Access Identifies whether 

the easement is 

open to public 

access or not 

Open 

Restricted 

Seasonal 

Closed 

Data not available 

Text 20 

Duration Duration Identifies whether 

the easement is 

permanent or term 

Permanent 

Temporary 

Data not available 

NO NULL 

Text 20 

Term Term Numeric field 

noting the term of 

the easement 

# Years Integer  

Acq_day Acquisition 

day 

Day easement 

began 

 Integer  

Acq_month Acquisition 

month 

Month easement 

began 

 Integer  

Acq_year Acquisition 

year 

Year easement 

began 

 Integer  

State State State in which the 

easement is 

located 

Domain Text 20 

DataAgg Data 

Aggregator 

Which of the 

project partners 

aggregated the 

data or entity who 

formatted the data 

to the NCED 

schema 

Conservation Biology 

Institute 

Ducks Unlimited 

Defenders of Wildlife 

NatureServe 

Trust for Public Land 

The Nature Conservancy 

Clemson 

Virginia Heritage Program 

(NO NULL - other values 

will be allowed, but notify 

CBI for their inclusion in 

the domain) 

Text 50 

DataEntry Data Entry 

Date 

Date when entered 

by NCED partner 

 Date  

DataProvider Data Provider Organization that 

provided the data 

No, but values should be 

ties to the Quickbase 

Inventory List and be in a 

standard format 

Text 100 

DataSource Data Source Source of the data No, but values should be 

ties to the Quickbase 

Inventory List and be in a 

standard format 

Text 100 
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Field Name Alias Field Description Domain Field Type Field Length 

OriginalUID Original UID Oringinal Unique 

Identifier from the 

data source, if any 

 Text 100 

BoundConf Boundary 

Confidence 

Description of the 

method by which 

the digitizing 

occurred, if known 

1:100,000 – National 

mapping standards 

1:100,000 

1:24,000 – National 

mapping standards 

1:24,000 

1:12,000 – National 

mapping standards 

1:12,000 

Cad2gis – CAD file 

converted to a shapefile, 

possibly georeferenced 

Cogo2gis – Coordinate 

geometry used to create 

scale boundary, manually 

placed 

Digbp – Digitized and 

georeferenced to best 

available control points  

Digquad – Digitized and 

georeferenced to features 

on the USGS quad  

Digspot – Digitized and 

georeferenced to SPOT 

imagery  

Digvbmp – Boundary 

delineated using features 

on VBMP 

Parcelq – Boundary 

originated from 

jurisdictional parcel data  

Scrdig – Boundary heads-

up digitized by 

referencing a map outside 

of GIS  

Survq – Georeferenced 

digital survey CAD file 

imported into GIS 

Unknown – Boundary 

accuracy unknown  

Digweb – Digitized within 

the conservation registry 

mapping interface 

Text 15 

ReportedArea Reported 

Area 

Area as reported by 

data steward, acres 

 Double  

GISArea GIS Area GIS calculated area, 

acres 

 Double  
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Field Name Alias Field Description Domain Field Type Field Length 

AreaDiff Area 

Difference 

Calculated 

difference between 

the GIS area and 

reported area 

 Double  

Conflict Conflict Status of conflict 

between other 

geometries 

No Known Conflict 

Conflict – Adjusted 

Conflict – No Adjustment 

Text 50 

Stacked Stacked Status of stacked 

polygons, whether 

stacking is accurate 

or not. 

Yes 

No 

Text 5 

Comments Comments Any comments 

from either the 

source, provider or 

aggregator 

 Text 255 

 


